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Abstract 

A concerning major pathway for contaminant transport into limestone aquifers is through major 
surface infiltration areas such as dolines. The Northern Guam Lens Aquifer (NGLA), a major 
source of the island’s utility water, has a surface plateau formed from uplifted and tilted geologic 
formations of limestone bedrock. This aquifer has a deep vadose zone (80-120 m) that may filter 
much of the rain infiltration and percolation, however, during intense rainfall when infiltration 
rate is exceeded, surface runoff occurs. The porous karst terrain on the plateau has connected 
surface depressions that may fill and overflow into a focal low point during intense rainfall. 
Runoff may easily transport cumulative and secondary sources of contaminants into its low 
areas. Some of these surface depressions have turned out to be sinkholes (collapsed and solution 
dolines) and fractures that are entry conduits, draining large volumes of potentially contaminated 
runoff into the freshwater source. This is a major concern with activities within these basins. If 
these activities are not carefully constructed and operated, anthropogenic contaminants may be 
transported to the water source and drawn up from nearby production well drawdown zones or in 
down gradient production wells. 

Guam Environmental Protection Agency is keen on regulating development over hydrologically 
significant sinkholes, fractures, and surface depressions that require hydrogeological assessment 
and site inspection. However, initial assessment via existing maps of closed contour depressions 
used to determine potential sinkholes were derived from old topography and has proven to have 
major inaccuracies and limitations. The development of a new map using the latest lidar based 
digital elevations (1 m raster resolution) and GIS hydrologic spatial analysis updates the island’s 
stormwater management over the aquifer. 

The surface hydrologic map products from this project applies modern technologies and  
high-definition data to advance our ways of determining aquifer protection. An online web map 
application, WERI Web MApps: Surface Hydrology of the NGLA, is now available on the 
Guam Hydrologic Survey website for use by Guam EPA, Guam Waterworks Authority, US 
Military, and island developers and planning agencies and contractors. These fundamental 
hydrologic maps of the NGLA are integral to the reassessment of groundwater protection zones. 
The surface hydrology of the NGLA is a frontline and online map product reference for 
determining strategic development plans over our precious water source. 

Keywords: Northern Guam Lens Aquifer, surface hydrology, plateau basin, watershed, fill, 
runoff, WERI Web MApps
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Chapter 1 

INTRODUCTION 

This study, titled Surface Hydrology of the Northern Guam Lens Aquifer (NGLA), emerged 
from several investigations carried out over recent years concerning development near suspect 
sinkholes or closed depressions located over the NGLA. Guam Environmental Protection 
Agency is keen and serious about identifying areas of potential contaminant and sediment 
loading and enforcing regulations on development activities around major surface depressions 
and fractures, especially ones with identified sinkholes, considered to be major recharge conduits 
to Guam’s fresh groundwater sources. The investigations utilized various GIS techniques, and 
applied fundamental hydrologic spatial analysis to the aquifer terrain. These GIS techniques 
determined specific hydrologic terminology (defined in Chapter 2), and a composite map of 
plateau basins, watersheds, fill areas, and runoff paths. These features revealed the runoff 
network of a drainage system of various areas located on the karst plateau. It was then 
determined that the same analysis should be applied for the entire NGLA in order to enhance 
geo-hydrologic mapping and to help developers decide strategies for storm drainage 
management. It was also decided that it would be desirable to train Guam interagency partners to 
use these hydrologic products in an all-out effort to improve Guam’s water resources protection. 

1.1 The Northern Guam Lens Aquifer 

The Island of Guam is a territory of the United States in the Western Pacific and is located 
approximately 1,560 mi southeast of Narita, Japan, and 1,600 mi east of Manila, Philippines. As 
of 2022, the population of the island was over 171,0001. The NGLA (Figure 1.1) is a 
physiographic region that includes the entire land area north of the Pågu-Adilok Fault. Guam’s 
land area is approximately 210 sq mi. The NGLA is approximately 102 sq mi, 49% of Guam’s 
total land area. The NGLA is an uplifted limestone plateau that has undergone karstification and 
forms a freshwater lens. The karstified plateau surface is highly porous and may deliver 
stormwater to the lens. The economic extraction and distribution of this groundwater resource is 
one important key to the prosperous development that has occurred on the island. This 
development includes residential areas where thousands of people are living over the NGLA. 

1.2 Statement of Water Resource Concern 

The Northern Guam Lens Aquifer is the island’s major source of fresh utility water. Because of 
the readily available water supply, much of the island’s population, development, and other 
activities are situated above the NGLA. As growth and development continue above this 
unconfined aquifer, the potential for anthropogenic contamination of the water resource 
increases. One of the major concerns is surface runoff that may easily bring together particles 
and soluble toxic byproducts that accumulate into surface depressions and sinkholes. These 
particles and byproducts can then flow into various conduits and fractures and eventually be 
transported into the freshwater zone and later may be drawn up by production wells  

 
1 https://www.worldometers.info/world-population/guam-population/ 



2 

 
Figure 1.1. Northern Guam study area and location. 

downgradient (see figure 1.2). Recent WERI-RCUOG hydrogeologic and hydrologic contract 
assessment reports for the development of military facilities included useful site maps and 
hydrologic terminology for karst plateaus such as the plateau basin (defined in Chapter 2). The 
plateau basin contains tributary watersheds that cascade stormwaters to a focal watershed. These 
watersheds often may have a conduit path to the groundwater known as a sinkhole. Guam EPA 
uses an old and sometimes inaccurate closed contour depression map extracted from contour 
topography maps to initially flag any development that poses a threat to the water source. This 
map is limited by inaccuracies compared to the hydrologic analysis of LiDAR based Digital 
Elevation Models (DEM). The closed contour depression map also does not have an organized 
surface hydrology of the plateau, which could help builders develop and strategize proper 
drainage systems. The closed contours are considered suspect sinkholes. Presently, field 
inspections by geologists verify hydrologically significant sinkholes. However, the map GEPA is 
using for regulatory purposes is from crude contour depressions, and their personnel should be 
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Figure 1.2. Plateau basin surface to groundwater transport schematics. 

trained in using these updated surface hydrology map products. The new high-resolution digital 
elevation based hydrologic maps developed from this project vastly improves surface analysis 
capabilities thus improving groundwater protection strategies. These analyses are useful and 
valuable for managing stormwater movement, identifying possible sinkholes, and strategically 
planning for major development over the aquifer. 

1.3 Goal, Purposes, and Specific Objectives 

The goal is the production of a fundamental surface hydrology map of the Northern Guam Lens 
Aquifer plateau. The purpose of a surface hydrologic map, as it also reveals potentially 
vulnerable areas for production wells, is ultimately for assessing and determining development 
strategies towards water source protection. Specific objectives of the study were to: 

1. apply hydrologic spatial analysis to the latest digital elevation model 

2. organize the hydrologic features and rasters to produce useful surface hydrology maps 

3. make the hydrologic maps available as a web map application 

4. provide workshop(s) for online access to maps and recommended use, most specifically 
for Guam’s regulating agencies (GEPA, GWA, and GDLM) and contract developers. 

The map products were developed with Environmental Systems Research Institute (ESRI) 
ArcMap and ArcGIS Pro. The resulting map products are made available via ESRI’s ArcGIS 
Online as WERI Web MApps and made available at the Guam Hydrologic Survey website. 
Another purpose for the use of these hydrologic map products is to provide everyone an 
awareness and attention to the details of the terrain, not to limit every development plan over the 
aquifer, but to achieve responsible plans, construction, and facilities, and proper designs, 
emissions control, disposal, confinement, and mitigations that keep the utility water source clean. 
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1.4 Scope, Limitations, Delimitations, Assumptions, and Disclaimer 

Scope: This project is a surface hydrologic analysis of the Northern Guam Lens Aquifer. The 
products are useful fundamental surface hydrologic maps and associated GIS files for 
determining areas that may require attention concerning hydrologically significant sinkholes that 
pose a possible contaminant transfer threat to Guam’s major groundwater resource. 

Limitations: The base data for all the analyses is the 2012 LiDAR derived bare-earth DEM of 
Guam. However, this DEM has areas where no elevation data is available, or “holes.” Chapter 2 
discusses the nature of the data, and Chapter 3 has a method applied for filling missing data. 
With these limitations, a disclaimer for its intent of use is provided below. 

Delimitations: Select limits were determined for the hydrologic analysis. Chapter 2, hydrology 
section, defines the hydrologic terminology used here. Watershed analyses are delineated around 
a fill area (closed surface depressions) greater than 300 sqm. The 300 sqm minimum value was 
selected in order to maintain a manageable number of fill area polygons in the GIS analysis. The 
plateau basins are further divided manually, such that the focal watershed, a terminal watershed 
in the plateau basin that has a deep fill area, has a maximum fill depth greater than 20 feet, which 
may never fill and overflow. Plateau basins do not reach the coast. Fill areas are suspect 
sinkholes until verified in the field. 

Assumptions: Because of the unique geology and geometry of the Northern Guam Plateau, 
certain assumptions were applied to the rainfall-runoff-contaminant transfer relationships that 
apply to the area. These include: 

1. The most significant effects of development activities over the NGLA will occur as a 
results of high intensity long duration typhoon related rainfall. These storms can result in 
as much as 2 feet of rainfall occurring in a single day. It is also well known that typhoons 
or intense storms occur in Guam. 

2. The high volume of typhoon related rainfall will fall on relatively saturated ground 
surface conditions causing high rainfall-runoff coefficients. This means that a high 
percentage of the rainfall will move through rainwater drainage ways toward the natural 
surface detention collection areas. 

3. It is likely that, during extremely high rainfall, water will overflow from higher to lower 
rainwater detention areas with possible movement of contaminants beyond the original 
rainwater collection area watersheds. 

4. Some of the depressions that serve as rainwater collection areas may or may not contain 
geologic sinks that tend to provide for high volume flow rates and fast flows from the 
detention area to the NGLA. 

5. Contaminants that have been deposited on or near the ground surface will most likely 
make their way to the detention collections areas where eventually they will be carried 
through the relatively porous Karst geology to the NGLA. 
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Disclaimer: This scientific study was designed to develop GIS spatial analysis techniques and 
subsequent maps for defining water flow topology on the relatively flat karst terrain overlying 
the NGLA. The basic aim of the project was to update the old USGS topography based closed 
contour depressions (as possible sink hole locations) provided by previous studies. On-ground 
surveys carried out during the study have shown that this study provided much improved 
location data over previous mapping. Even though this is the best hydrologic analysis available 
at this time, the data and maps should be used with caution and as a guide for determining where 
detailed on ground investigations are required. 

1.5 Benefits 

The hydrologic maps developed in this study updates the methods of assessment and reevaluates 
and fine tunes methods of protecting the aquifer. This in turn give GEPA and GWA the map 
reference to promote cooperative protective development of the area overlying the NGLA. The 
workshops and training that are proposed assures that the data is most reliable, useful, and 
available to both regulating agencies and those proposing development over the aquifer. The 
bottom line is that the NGLA will be protected both now and in the future for all the people of 
Guam. 



 

Chapter 2 

BACKGROUND AND REFERENCE LITERATURES 

The development of this project titled, Surface Hydrology of the NGLA, emerged from the 
planned construction of the US Marines facilities, complex, and training site in Northern Guam. 
WERI-RCUOG (Research Corporation UOG) was consulted to investigate site suspect 
sinkholes, which included hydrologic analysis of the terrain. Using a high-definition Digital 
Elevation Model (DEM) and GIS hydrologic analysis, the investigation went beyond sinkhole 
determination/verification and analyzed the surface hydrology at proposed development sites. 
The surface hydrology analysis proved to be integral in developing an understanding of the 
terrain, hydrologic processes, and drainage network, in and around the areas of interest. Results 
of the analysis helped the contractors strategize facility design, determine mitigation, and 
become aware of aquifer protection and vulnerabilities. Soon after completion of this project, 
WERI decided that the same hydrologic analyses should be applied to the entire NGLA, so 
contractors may configure the best designs over the aquifer. This chapter covers the background 
and literature of aquifer characteristics and properties pertaining to the plateau terrain, aquifer 
protection and regulations on development over the aquifer, GIS data source and quality, and an 
overview of the hydrologic terrain analyses methods that were applied to meet the specific 
objectives of this report. 

2.1 Geology, Hydrology, and Hydrogeology of the NGLA 

The NGLA’s limestone plateau consists of effective stormwater drainage terrain. The terrain is a 
result of millions of years of karstification processes and speleogenetic collapse that has 
developed an enhanced surface and subterranean drainage system. The aquifer is very receptive 
to stormwaters that either runoff or cause ponding. Flooding is ephemeral with exemptions at 
less pervious areas such as in the argillaceous limestone formation where streams occur or at 
fines-deposit filled and layered depressions. Unlike typical mountain valley watersheds with 
surface flows of streams and rivers that flow overland all the way out to the sea, the NGLA 
plateau has many large basins of watersheds that may overflow stormwaters that converge into a 
deep closed surface depression—sinkhole. Sinkholes may have subterrain conduits that reach the 
freshwater source. The following subsections cover the geology, hydrology, and hydrogeology of 
the NGLA in greater detail. 

2.1.1 Geology 

The NGLA is a result of 16 M years of limestone unconformity on an uplifting volcanic 
basement. Periodic deposition of limestone, mainly Barrigada and Mariana, formed on a volcanic 
formation, Alutom (Tracey et al. 1964). Mariana Limestone, 3-2 mya, formed on and around the 
Barrigada Limestone (16-3 mya). These features comprise the two major limestone formations of 
the NGLA bedrock. The major basement uplift (~2 mya) resulted in a fractured, faulted, and 
tilted limestone plateau (200-500 ft amsl). The faults and fractures became the major 
subterranean drainage and possibly a major route of underground flow, where large dolines form. 
Another source of surface depression is speleogenetic collapses from subterranean cavities. 
These faults and fractures form solution dolines, cockpit karst terrain, and polygonal karst 
landscapes, possibly from freshwater lens interfaces of horizontal caverns, including cavities of 
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former freshwater lens positions. Although karst geology is highly complex, most interestingly 
discovered from GIS terrain and hydrologic analysis is the organization of cascading overflow 
runoff paths or a watershed throughflow system in the NGLA’s plateau basin. This system 
delivers stormwaters to a focal watershed, a deep fill area doline (see Figure 1.2). 

The NGLA has undergone karstification and speleogenesis, since carbonate bedrock is partially 
soluble, undergoes weathering, erosion, deposition, and dissolution, resulting in voids and 
weakening of surrounding structure. Some of these subterrain voids collapse, and surface 
depressions or subsidence occur. Limestone dissolution forms cavities and weakens the rock 
structure, and the overburden stress eventually causes collapsing resulting in a sinkhole (Bonacci 
2015). Thus, sinkhole evolution is a subterrain process borne of water movement through 
dominant pores, enhancing size through dissolution, and weakening of pore side walls. Karst 
triple porosity enhances heterogeneity and anisotropy, or either way, promotes the dissolution 
and deposition process, weakening and strengthening the limestone bedrock for surface collapse 
to occur. 

Limestone dissolution, speleogenesis, is known to occur at the freshwater lens interfaces, 
between unsaturated-saturated (water table) and saturated freshwater-saltwater, also referred to 
as the transition zone (Dougher et al. 2019). The lifted plateau reveals former sea level and lens 
position, evident throughout the karst perimeter, breached as flank margin caves. Subterranean 
cavities are also evident in borehole data. 

Dissolution also occurs at fractures, limestone formation contacts, and in voids between 
basement and bedrock. Voids enlarge at conduits, fractures, and contact gaps, where infiltrated 
water flows quickly. At contacts, the weaker dissolvable material may transfer or be displaced, 
increasing flow, and enlarging into a cavity. Some of these collapsed voids result in sinkholes, 
often expressed in surface depressions, with conduits and fractures that reach from the 
groundwater to the surface depression. 

The types of sinkholes found on the NGLA are solutional dolines, collapsed dolines, uvalas, 
poljes, banana holes, and cenotes. Map terrain analysis on the plateau reveal that large dolines 
are found along faults and fractures, however, map and field investigation also observed that 
many sizes of dolines are common. Many parts of the plateau are characteristic of doline and 
cockpit karst evolution in progress (Williams 1985), which may explain much of the surface 
hydrology flow patterns on the plateau. Hydrologic analysis of surface watersheds and runoff 
paths over the NGLA reveals a polygonal karst landscape (Ford and Williams 2007). 
Accordingly, polygonal terrain is a result of surface collapse into underlying caves. This uplifted 
aquifer, based on sea notches on the plateau edge along the coast, had undergone sea level 
stands, along with former freshwater lens position interface speleogenesis. Some of the shallow 
surface cavities may be due to cavities from former lens position. Polygonal karst has a very well 
developed and efficient drainage system (Ford and Williams 2007, Williams 1985), thus draining 
over the NGLA is mostly fairly quick even during major storms. 

GIS hydrologic terrain analyses of the NGLA greatly reveal the faults, fractures, strikes, and 
lineaments, thus enhancing visibility of dip-slip faults and graben and horst. As mentioned 
above, large dolines form along major faults and fractures. Major faults have large depressions 
and tend to have parasitic faults and fractures that have smaller closed surface depressions 
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(Jenson et al. 2020). Some of the depressions along these resulting faults have been found to 
have swallow holes. Large depressions in focal watersheds often have soil accumulation at its 
low point and deep ones may never overflow to the next watershed. 

Large dolines are visible with satellite imagery (even with the canopy); however, the vegetation 
cover limits visibility of a lot of the important finer details concerning hydrology. Taborosi et al. 
(2006) extracted closed contour depressions from a contour map of Guam. GEPA uses this 
closed contour depression map to flag for suspect sinkholes. From 2015–2020, Habana applied 
hydrologic analysis to LiDAR based DEM (bare-earth) on the NGLA to reveal the surface 
hydrology of a basin of watersheds, fill areas, and runoff paths. These included boundary 
flowthrough drainage networks in several construction project sites (Jenson et al. 2018-2020). 
These analyses were used to analyze development and activities impact to the water source. 

2.1.2 Hydrology and terminology 

Karst plateau terrain hydrology differs from typical mountain valley streams, watersheds, and 
basins. The runoff paths can have spatially varied permeability, which makes the terrain difficult 
to assess (Bonacci 2015). The surface hydrology of the NGLA is a result of karst processes that 
have been carved by stormwater that developed a drainage system of paths in the karst plateau. 

The NGLA plateau terrain is an exceptional rain catchment system for aquifer recharge. This 
system has been mapped in several consultant reports. In 2019, the Mokfok Plateau Basin and 
tributary watershed drainage system was mapped in a hydrologic assessment report (Jenson et al. 
2020) for the development of US Marines urban combat training facility in the MARBO area. 
Other reports include sinkhole and hydrologic assessments that including maps of surface 
hydrologic analysis for the US Marines facilities, Camp Blaz, and Firing Range (Jenson et al. 
2015-2020). The surface hydrology studies over these local sites provided valuable strategic 
information that is useful for determining aquifer protective measures including design 
modifications and mitigation measures. 

The following hydrologic terminology updates and refines earlier terminology used in the 
investigation reports mentioned above. The following hydrologic terminologies are based on 
specific ESRI spatial analysis hydrology tools and some distinct terms for the special hydrologic 
analysis and unique hydrology in Guam’s karst plateau. These terminologies and definitions are 
part of the GIS hydrologic analysis features of interest that were derived from the DEM. The 
delimitations and assumptions described above were used as boundary conditions in the applied 
methods. 

Fill area (fillable area): The areal extent of a closed surface depression, also referred to as closed 

contour depression, in a watershed that receives runoff during high intensity rainfall and often 
collects water. Figures 2.1 and 2.2 illustrates fill areas. Fillable area also refers to a fill analysis 
of a DEM, which is the result of the filled DEM minus the original terrain DEM, and can be 
converted into a polygon. This method results in the best mapping of the areal extent of a surface 
depression. The fill analysis is a program that assumes the closed depression does not drain and 
would fill to its overflow point, thus the areal extent of the depression is limited to the overflow 
point elevation. This point is where a fill area touches a watershed boundary. If the fill area 
should receive any more rainwater, it would then overflow to the next watershed. These fill areas  
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Figure 2.1 Fill area and watershed, cross-section schematic. 

are often considered suspect sinkholes, and the surface depression may be a result of a sinkhole. 
The suspect sinkhole is only confirmed a sinkhole by field inspection and analysis. Field surveys 
have found that deep and large fill areas are often sinkholes. Many fill areas may not fill to their 
overflow point in the watershed, especially deep ones, which may determine the focal watershed 
(see definition of focal watershed below). 

Fill area depth (fillable area depth): The fill area depth is the depth of the fill level, based on the 
fill analysis. This depth is the resulting difference between the fill DEM and the original DEM. 
This is a high-resolution raster depth based on the fill area elevation. The fill depths reveal the 
lowest point of the fill area and the shape of the depression as depth. 

Overflow runoff path (ORP): A main runoff path resulting from an overflowing fill area. This 
path begins at the overflow point and flows into the next fill area. See Figure 2.2 for an  
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illustration of ORPs. This major runoff path connects water between two fill areas during intense 
rainfall events, especially typhoons. This overflow begins at the lowest elevation of a watershed 
boundary that meets the edge of a fill area overflow point. Overflow runoff paths are identified 
using GIS stream order hydrologic analysis. Streams with stream order values greater than or 
equal to 5 tend to be ORPs. ORPs assumes a filled CCD condition. Streams with stream order 
values within the 1 to 4 range usually constitute normal watershed runoff routes. 

Watershed (WS): A rainfall catchment area that pours into a closed surface depression or fill 
area, with a surface area greater than or equal to 300 sqm (3,229 sqft), (see delimitations). The 
hydrologic analysis applied is watershed, using the fill areas (≥ 300 sqm) as the pour area. 

Focal watershed: A watershed with a closed surface depression that will not overflow. The focal 
watershed was determined as having a fill area depth greater than 20 ft (6 m). While overflow of 
fill area depths of 10 ft or less have been observed by watermarks in dolines, we assume that a 20 
ft depth is a reasonable maximum to never overflow. A focal watershed is the terminal watershed 
for tributary watersheds and overflow runoff paths. Also, most focal watersheds have a sinkhole 
or doline and may be a major route for fast recharge to the aquifer. 

Tributary watershed (TW): A series of watersheds that are connected by verifiable overflow 
runoff paths from the head watershed to the focal watershed. 

Tributary watersheds divide (TWD): The ridgeline dividing flow between tributary watersheds. 

Runoff path: The ephemeral flow paths or throughflow in a karst terrain watershed that route 
rainwater into the fill areas during high or intense rainfall periods. See Figure 2.2 for an 
illustration of runoff paths. These runoff paths are delineated as the valley routes, ruts, and 
channels of a watershed, including storm drain systems, mapped with the GIS hydrologic 
analysis, accumulation. Accumulation analysis is often used to delineate stream paths in a 
common valley watershed. Runoff paths have stream order values (see section 3.4, Strahler 
stream order) that identify watershed runoff paths and overflow runoff paths. Runoff paths may 
be natural or artificial (storm drains and channels). 

Plateau basin: A hydrologic basin that is a collection of tributary watersheds and a focal 
watershed. However, it is possible that a plateau basin may have a single focal watershed. Recall 
that northern Guam is an uplifted karst plateau. Plateau basins are first delineated using the GIS, 
hydrologic analysis, Basin. This analysis required a filled DEM. However, the basin program 
does not account for the focal watershed. The plateau basin is then further refined by determining 
the focal watershed, which has a fill area depth greater than 20 ft, and is bounding all tributary 
watersheds that flow into that focal watershed. Plateau basins do not reach the coastline. Basins 
that reach and discharge to the coastline in this study are called coastal basins. 

Karst plateau basins in the NGLA vary in areal coverage. Large plateau basins capture large 
quantities of rainwater. Guam’s average annual rainfall ranges from 80 to 120 in/yr. Rainfall 
intensities may exceed 6 in/hr. A maximum intensity of 8 in/hr was recorded during Typhoon 
Pongsona (Lander 2021). Rainfall from typhoons has been reported to have exceeded more than 
20 in/day. Low rainfall either infiltrates the permeable surface or is evaporated. Runoff is 
observed on road surfaces with rain intensities greater than 0.03 in/min (1.8 in/hr) (Lander 2021). 
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Figure 2.2. Basic schematic of a plateau basin, plan view. Plateau basins have tributary 
watersheds and a focal watershed. 

While storms can result in runoff and ponding, typhoons may cause overflow from a 10 ft deep 
depression. In 2002, during Typhoon Pongsona, 25.6 in of precipitation was measured in a single 
day at the University of Guam (Evans et al. 2003), and many ponding basins were nearly filled 
or overflowed in the village of Dededo, located over the NGLA. Daily rainfall intensities in this 
range coupled with extremely high hourly intensities in the typhoons outer bands and eye wall 
were likely to cause the fill areas to overflow and cascade into the next downstream depressions. 

During lower rainfall events, a watershed collects rain that infiltrates into the surface. If the 
rainfall rate exceeds the infiltration rate, runoff occurs and may flow to the watershed’s closed 
surface depression, and can continue infiltrating usually as slow recharge. That is the case if the 
surface depression does not have a sinkhole. If rainfall is insufficient to fill all watersheds in the 
tributary watershed, then runoff may terminate at a watershed and never reach the basin’s focal 
watershed. During storms, especially typhoons, overflow runoff cascades through tributary 
watersheds. Large plateau basins often have several tributary watersheds that may route a high 
volume of runoff into the focal watershed. 

2.1.3 Hydrogeology and utility water production 

The subterrain area of the limestone plateau has a vadose and phreatic zone. The vadose zone or 
unsaturated zone is mostly unconfined, especially at sinkholes, conduits, faults, and fractures. 
However, quarries and boreholes reveal a variety of porosity from horizontal cavities, leaky 
hardened limestone strata, massive impervious boulders, and doline and cockpit karst processes 
(Williams 1985). 

The phreatic zone is a freshwater lens that accumulate atop the underlying saltwater. The lens 
receives autogenic and allogenic recharge. Dougher et al. (2019) analyzed temporal water level 
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and CTD of three deep observation wells that reveal the freshwater lens, transition zone, and 
saltwater beneath to observe the phreatic response to storms and droughts. Stormwaters from the 
surface deliver fast recharge to the freshwater lens through closed surface depressions. The 
freshwater lens is vulnerable to contamination from surface flow related to groundwater transport 
routes. The focal watershed is a fast flow route (Jocson et al. 2001, Habana et al. 2009) into 
subterranean fractures and conduits that deliver stormwater into the freshwater lens. 

The latest subsurface hydrogeologic map is the NGLA map (Habana and Jenson 2018) that 
integrates the NGLA groundwater model resulting water table contours (Gingerich 2013). These 
hydraulic head contours suggest flow direction, which is often used to determine flow direction 
and likely plumes of transported contaminants. Flow lines from a sinkhole or doline to 
production wells are often drawn to illustrate potential threats to the wells. Previous reports 
(Jenson et al. 2019-2020) combined the surface hydrology with the groundwater map to help 
investigators identify production wells that are down-gradient from closed surface depressions. 

The NGLA is a federally registered sole source aquifer designation, and its freshwater lens 
supplies up to 90% of the 45 MGD utility water production. Blum (1978) noted the aquifer’s 
vulnerability to contamination through recharge zone that can be hazardous for utility drinking 
water. A total of 90-105 active production wells operated by local and military water authorities 
produces and distributes a total of about 42 MGD in order to supply the island’s water utility 
demand. The NGLA has 6 aquifer or groundwater basins. Tumhom Aquifer Basin is a major 
source, producing nearly 20 MGD, which is about half of the total groundwater production. The 
abundance of water in this basin results the most developed and populated area. Guam EPA and 
USEPA monitors production wells for regulated levels of turbidity, pathogens, and contaminants. 
Any exceedance of MCLs will require termination of water production at any well. GEPA also 
has a well head protection zone and other aquifer protection regulations, referred next. 

2.2 Water Resource Protection Regulations and the SEIS 

GEPA monitors MCL at production wells and applies aquifer protection regulations. GWA, 
through WERI, tests its wells and submits water quality reports to GEPA. Heitz (2014), observed 
select production wells for GEPA and USEPA, to determine if the wells are Groundwater under 
the Direct Influence of Surface Water (GWUDI) and the Surface Water Treatment Rule 
(SWTR). GEPA has many regulations that are applied to development over the aquifer. Three of 
the commonly applied protective and preventive measures for development include: 
Groundwater Protection Zone, Well Head Protection Zone, and development on or near 
sinkholes (BHA-CDM 1982, GEPA 1997). In practice, contractors are required to have their 
planned development investigated to determine water source impacts from developing near 
wells, in the groundwater protection zone, and on or near depressions and sinkholes. 

Development contractors share maps of planned development to regulating agencies for 
investigation. Maps including the contract area are shown in the SEIS (Supplemental 
Environmental Impact Statement). The SEIS is often referred to as a colored perimeter “box”: 
“red box,” or “green box.” The maps also include closed contour depressions, considered to be 
suspect sinkholes. GEPA today uses closed contour depressions (Taborosi 2006) as the map 
guide to suspect sinkholes. Depressions and sinkholes are often considered useful for wastewater 
and stormwater disposal areas. In Guam they are commonly developed into ponding basins for 
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Figure 2.3. Contract area, watershed, and suspect sinkhole. 

 
Figure 2.4. Overflow beyond the contract area. 

residential and business areas. At the same time, as mentioned, they are concerningly conduits to 
the freshwater lens. Recent consultant analysis has gone beyond determining whether closed 
contour depressions are sinkholes to include the investigation of the surface hydrology as well. 
Figure 2.3 and 4, are schematic diagrams from recent WERI-RCUOG investigations (Jenson et 
al. 2019, 2020) and illustrate how stormwater may overflow and runoff outside the contract area, 
and cascade to the lowest elevation. Surface hydrology analysis has changed from the classic 
manual contour delineation to application of GIS hydrologic spatial analysis to LiDAR 
(Appendix) based digital elevation models (DEM). 

2.3 Data Quality 

The key basis for the precise GIS hydrologic analysis is the 2012 Guam DEM, bare-earth. The 
2012 DEM is the latest and most precise raster elevation map of Guam. The vertical accuracy 
assessment of the data has a project requirement to achieve a RMSE of 12.5 cm (0.41ft), a 
Fundamental Vertical Accuracy (FVA) of 24.5 cm (0.80 ft) at a 95% confidence level, a 
Consolidated Vertical Accuracy (CVA) of 36.3 cm (1.19 ft) at the 95th Percentile and a target 
value for Supplemental Vertical Accuracies (SVA) of 36.3 cm (1.19 ft) at the 95th Percentile. 
The Fundamental Vertical Accuracy (FVA) is determined with checkpoints located only in open 
terrain where there is a high probability of having LiDAR return from the bare-earth ground 
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surface and where errors are expected to follow a normal error distribution. While FVA values of 
24.5 cm (0.8 ft) are not too impressive compared to actual field survey determinations, they are 
by far the most accurate elevation data available for use in hydrologic spatial analysis. We must 
keep in mind that the hydrologic spatial analysis is dependent more on the relative elevation of 
the DEM cells rather than the actual values that could be determined using ground survey or GPS 
methods. The relative elevations accuracy of the bare-earth DEM can be assumed to be better 
than the FVA values. We therefore assumed that the bare-earth DEM values are adequate for this 
study. When and if future new and more accurate DEMs are available the spatial analysis 
processes described in this report can be easily reapplied to that new data.  

The 2012 bare-earth DEM has null values. These null values are found at corners of tile pieces of 
the DEM, possibly a result of the construction of the entire DEM of the island. Null values are 
also found at places where large buildings stand. A GIS method to patch these “holes” was 
applied, resulting in a seamless, smooth filling of elevation values throughout the DEM (details 
are in section 3.1). 

2.4 Application of Surface Hydrology Analysis 

The objective of this research is to apply fundamental hydrologic analysis to the latest and best 
available digital elevation model to determine the hydrologic rain catchment boundaries and 
runoff paths on the plateau surface. This is most easily achieved and best delineated using GIS 
and spatial analysis hydrology tools. These tools are based on the development of GIS map 
algebra packages for advancement of watershed terrain analysis and environmental modeling and 
management (Guertin et al. 2000, Tomlin 1980). 

The analyses first assumes that there are no sinking streams nor infiltration ponds in order to 
identify an area’s ultimate hydrologic boundaries and storm flow paths. However, it is advised 
that the map products from this report are to be used with discretion and mindfulness of the real 
hydrology of the NGLA and its limestone plateau basins, expecting high permeability on 
watershed area, along the runoff paths, and surface depressions. And that surface runoff occurs 
when rainfall intensity exceeds the permeability or infiltration rate, often observed during major 
storms. The maps are best used as a first step guide for gaining insight and as an overview for 
field investigation. Field investigators (Jenson et al. 2015-2019) have expressed the great value 
in these types of maps, as it assists with maintaining location and bearing, especially with the 
limited visibility in the thick jungle canopy and magnitude of the dolines. 

The products are a map of layers including plateau basin and watershed boundaries, and runoff 
paths as defined above. The terminology is mostly hydrologic and based on the analytic methods 
used to determine such boundaries. Basins contain watersheds and a watershed contains a fill 
area. A stream method was used to delineate runoff paths. Fill depths reveal the lowest point of a 
fill area that may possibly be where a sinkhole is located. 

The products are maps of the surface hydrology that will serve to identify critical areas, natural 
storm drain systems, and hydrologic boundaries. Ultimately, island developers and regulators can 
be trained to use the maps, via workshops, in an endeavor towards protecting the water source. 
We recommend that these hydrologic map products be used by all those proposing development 
over the NGLA.



 

Chapter 3 

METHODOLOGY 

The goal of this project was to map the fundamental hydrologic areas, boundaries, and runoff 
paths on the NGLA plateau. The objectives were to produce the hydrologic features discussed 
and defined in the previous chapter. GIS map application and hydrologic analysis tools were 
applied to the 2012 LiDAR based DEM. The following sections cover the details of the data, 
applications, and analyses. The fundamental hydrologic features produced were overlayed to 
map the plateau surface hydrology of the NGLA. This mapping is most integral for determining 
water resource protection strategies. 

3.1 GIS Application, Data Refinement, and Map Analyses 

The specific mapping applications for hydrologic analyses are ESRI’s ArcMap, ArcGIS Pro, and 
ArcGIS Online. The GIS tools applied in the following sections can all be accessed through the 
ArcMap Arc Toolbox, which is available under the menu items in the ArcMap and ArcGIS Pro 
user interface. The analysis tools used were Spatial Analyst, Hydrology. ESRI has documents for 
applying the hydrology toolset, and the internet has many searchable sources of documents and 
videos of GIS hydrology methods and techniques as well. The subcategory tool methods were 
Fill, Flow Direction, Accumulation, Basin, Watershed, and Strahler Stream Order. Other Spatial 
Analysis tools were Map Algebra, Nearest Neighbor, and Extraction. Other GIS tools included 
conversion from raster to feature and vice versa. A standard notation is applied for providing 
information on accessing the tools that were used for each computational process. For example, 
if spatial analyst fill tool is used, it is referenced accordingly (ArcToolBox >Spatial Analyst 
Tools>Hydrology> fill). A description of the required input files for each tool is also provided. 

The DEM described in Chapter 2 is the basis for all the GIS hydrologic spatial analyses that were 
applied. This DEM represented the bare-earth (vegetation and buildings removed) elevations of 
the ground surface. The coordinates are in meters, projection UTM WGS 84 Zone 55N, and the 
metric elevation cell values were converted to feet (ArcToolBox>Spatial Analyst Tools>map 
algebra). The WERI Hydrologic Web MApp products coordinate system is Auxiliary WGS 84. 

3.1.1 Null values, “holes” in the DEM 

As mentioned in Chapter 2, the 2012 LiDAR based DEM has null values, or “holes.” These null 
values are found at corners of tile pieces of the DEM, possibly a result of the construction of the 
entire DEM of the island. Null values are also found at places where large buildings stand. These 
null values affect the result of the hydrologic analysis and had to be first patched with an 
interpolation process. 

A GIS method to patch these null values was applied. A point-shape perimeter was produced for 
each raster cell surrounding the holes. This was done by converting the holes into a polygon, and 
then creating a 1 m (raster cell size is 1 m) buffer to the perimeter of the holes. Then, the buffer 
polygon is used to extract the raster cells from the DEM, surrounding the holes. The perimeter 
raster cells were converted into points with elevation values. Next, a natural neighbor 
interpolation analysis (ArcToolBox>Spatial Analyst Tools>Interpolation>Natural Neighbor) is 
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applied using the point perimeter values. The resulting nearest neighbor cells in the hole is then 
extracted. Finally, map algebra (raster calculator; ArcToolBox>Spatial Analyst Tools>Map 
Algebra>Raster Calculator) was used to fill the holes with the interpolated values. The result is a 
seamless elevation patch work that fills into the previous null values and blends well with the 
surrounding raster cells. This patched DEM was used for all of the GIS analyses applied. 

3.1.2 The surface hydrology analysis overview 

Various ESRI ArcMap Geographic Information System (GIS) tools were applied to the LIDAR 
based DEM of the NGLA in order to accomplish the following: 

1. delineation of fill areas and fill depth 

2. delineation of a watershed surrounding a delimited fill area 

3. production of runoff paths to the fill area 

4. delineation of plateau basins 

Section 2.1.2 defines these hydrologic features and rasters. The features and rasters are then 
combined to produce interactive internet web browser accessible maps. 

3.2 Fill Area and Fill Depth (closed surface depression) 

The fill areas and fill depth were processed with fill analysis. These fill areas receive rain 
induced runoff. Figure 3.1 is an outline of a plateau basin, a sample area for illustrating technical 
hydrologic analyses that were applied to the entire NGLA. In order to develop a map of the fill 
areas and runoff paths, it was first necessary to develop a new DEM that filled up all the surface 
depressions. The fill tool (ArcToolBox>Spatial Analyst>Tools>Hydrology>Fill) was applied to 
the null-removed bare-earth DEM (section 3.1.1). A flow direction raster file was also developed 

 
Figure 3.1. Large plateau basin used to illustrate the analyses techniques. 
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from the filled DEM. This file was developed by applying the flow direction (ArcToolBox> 
Spatial Analyst Tools>Hydrology>Flow Direction) to the filled DEM. The flow direction file 
will be used later to produce the runoff paths. The resulting DEM consisted of the required fill 
elevations to assure outflow from each cell. Next, the raster calculator tool was applied to 
subtract the original DEM from the fill elevation DEM. 

The result was a DEM with the fill depths for values for all the surface depressions. The fill 
depth raster was converted to polygon features, as fill areas, using raster to polygon (Conversion 
Tools>From Raster>Raster to Polygon). The first process for fill area resulted in many small 
polygons that were too much and unmanageable, requiring delimitation. An area distribution 
analysis provided the selection of the most manageable size, and 300 sqm fill area was 
determined minimum as the frequency distribution of greater than 300 sqm was manageably 
reduced, and later would contribute to produce reasonable sized watersheds. Also, most fill areas 
less than 300 sqm was found shallow, was considered to simply fill and overflow, thus less 
significant. However, the first process (unfiltered fill) was used in the final maps as a selectable 
layer. The smaller depressions were filtered using the select option (ArcToolBox>Analysis 
Tools>Select) with a selection criterion of greater than 300 sqm. Figure 3.2 shows the resulting 
polygon map of the fill areas. This delimited fill area was used to reconstruct the fill DEM (used 
in the runoff path feature process) into to a filled DEM of delimited fill areas, a process of 
adding (raster calculator) the delimited fill depths to the DEM, referred to in the runoff section as 
the 300 raster file. 

 
Figure 3.2. Fill area (area of closed surface depression). 
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3.3 Surface Watersheds of Delimited Fill Areas 

Watersheds were produced using the watershed tool and delimited fill areas. This is 
accomplished with the hydrologic analysis watershed (ArcToolBox>Spatial Analyst 
Tools>Hydrology>Watershed) applied to the Northern Guam filled DEM Flow Direction and the 
delimited fill polygon files. The result is a raster of watersheds of delimited fill areas that was 
then converted to polygons (Raster to Polygon). Figure 3.3 shows a sample of the results of 
applying the watershed tool as specified. 

 
Figure 3.3. Watershed boundary of a delimited fill area. 

A watershed is a rain catchment area (thus, has a boundary) where runoff and overland flow 
move to the fill area. Notice where the fill area meets the watershed boundary—that is the 
overflow point should the fill area ever reach its fill capacity and overflow to the next watershed 
fill area (overflow runoff path). 

3.4 Runoff Paths 

The approach used to obtain runoff paths was to first apply the flow accumulation tool 
(ArcToolBox>Spatial Analyst Tools>Hydrology>Flow Accumulation) to the previously 
developed filled DEM flow direction raster file (section 3.2). This tool creates a new raster 
containing the number of accumulated upstream cells for each cell in the flow direction DEM. 
Next, the map algebra tool (ArcToolBox>Spatial Analyst Tools>Map Algebra) was used to form 
a subset of the cells contained in the original accumulation raster. The stream to feature tool 
(ArcToolBox> Spatial Analyst Tools>Hydrology>Stream to Feature) to the accumulation greater 
than 300 raster file to obtain a polyline file of the rainwater flow pathways. The derived runoff 
paths are shown in Figure 3.4. The line widths of the runoff paths are plotted proportionally to 
the logarithm of the cell accumulation in the path. 
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Figure 3.4. Derived runoff paths. 

Figure 3.5 is a closeup view of runoff paths. Next process was stream order (ArcToolBox> 
Spatial Analyst Tools>Hydrology>Stream Order) to the previously developed accumulation 
analysis of the greater than 300 cells filled DEM flow direction raster files. Stream order 
provides a mean to describe the hierarchical location of stream segments withing a stream 
system. Figure 3.6 is the concept of the Strahler stream order system. This resulted in a new 
raster file of the stream order for all the segments of the previously identified runoff paths. The 
result is a set of polylines of stream order values. Polylines less than 5 (Strahler order) are 
watershed runoff paths, higher order paths represent the paths connecting the fill areas across 
watersheds—as overflow runoff paths. 

3.5 Plateau Basins 

The plateau basin is derived from the filled DEM. It is a basin where no water can escape on the 
surface. These basins are defined by applying the basin tool (ArcToolBox>Spatial Analyst 
Tools>Hydrology>Basin) to the previously developed filled flow direction raster files. Figure 3.7 
shows the basin outlines for all the surface basins located over the NGLA. The area delineated in 
blue is the example basin shown in the previous figures. The real depth capacity required to 
overflow from the storms intensities that occur in Guam is difficult to determine for each fill 
area. The basin analysis is not programmed to determine that as well, thus the actual basin may 
be smaller than computed. To simplify this condition, a delimitation was set at closed surface 
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Figure 3.5. Closeup view of runoff paths. 

 

Figure 3.6. Concept of Strahler Stream Ordering Method. 
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Figure 3.7. Basin analysis. 

depressions of depths greater than 20 ft and its watershed define focal watersheds. It is 
considered that these deep surface depressions do not overflow into the next watershed under the 
most intense storm. These were identified from the fill depth (section 3.2) of a fill area. These 
delimited focal watersheds and its tributary watersheds enclose the basin. Since there are basins 
that contained more than one focal watershed within their delineation, the basin boundary was 
redefined manually to either contain only one focal watershed, or as basins considering 
CHamoru name place basin areas. Thus, the plural plateau basins (e.g., Mokfok basins) may 
have more than one focal watershed. Manual editing of the basin polygon was accomplished 
using trace and append to divide and redefine the boundaries (see Figure 3.8). The basins were 
given CHamoru names in collaboration with Kumisión i Fino’ CHamoru and WERI-RCUOG 
(see Figure 3.9). 
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Figure 3.8. Final basin analysis redefined with respect to delimited focal watershed and the 
consideration for CHamoru name of plateau basins. 

 
Figure 3.9. CHamoru names of plateau basins. Plateau basin names were determined by the 
Kumisión I Na’an Lugåt Guahan (Guam Place Names Commission) and WERI-RCUOG, 2021. 
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3.6 Hydrologic Web MApp Products 

The GIS shapefiles (basins, watershed, runoff paths, fill area, and contours) and map rasters (fill 
depth and flow direction) were combined to create a useful map of the NGLA surface hydrology. 
This was then uploaded into ArcGIS Online to create an interactive web mapping application, as 
WERI Web MApps: Surface Hydrology of the NGLA (Figure 3.10). The next chapter (Results) 
shows how to use the Web MApp interface and internet access to four hydrologic map products. 

 
Figure 3.10 WERI Web MApps: Surface Hydrology of the Northern Guam Lens Aquifer.



 

Chapter 4 

RESULTS 

Findings for each hydrologic spatial analysis and the resulting map products are briefly discussed 
and illustrated in this chapter. The four main hydrologic analyses resulting in shape features and 
raster of the 2012 LiDAR based DEM of northern Guam are: fill area, watershed, runoff paths, 
and plateau basins, and a raster map for fill depth. Plateau basins were given CHamoru names, 
determined and approved by the CHamoru name place Kumisión (commission). Sample result 
figures of each hydrologic analysis are illustrated in the following sections. The final products 
are a combination of these map features and rasters, overlaying a select background with surface 
elevation contours. Four map products were then uploaded to WERI’s ArcGIS Online account 
and developed into interactive web map applications as WERI Web MApp products. These 
hydrologic WERI Web MApp products were first unveiled in the Guam Advisory Council 
Meeting, November 2021, and made available on the Guam Hydrologic Survey website. 

4.1 Fill Areas (closed surface depression) Analysis 

Application of GIS’ hydrologic fill analysis is the best method to delineate fill areas or closed 

surface depressions, also referred to as closed contour depressions. Fill analysis is the most 
precise method versus the classic extraction of topographic depression contours since the 
elevation of a fill may be between contour intervals. As described in the methods section, fill 
hydrologic spatial analysis of the 2012 DEM (LiDAR based, bare-earth) of northern Guam was 
applied to obtain a filled DEM. Then, a raster calculation difference of the filled DEM and the 
original DEM was made to produce a hydrologic fill depth (Figure 4.1) measured from the fill 
area elevation to the original DEM. After converting the fill depth to a single value (e.g., 
multiply by zero), the fill depth may be converted into a polygon shapefile. The unfiltered fill 
analysis produced a large number of small fill areas (Figure 4.2). This was then delimited (see 
Chapter 1) to fill areas greater than 300 sqm (Figure 4.3). The largest fill area is located in the 
northwest region of the island and the deepest are two quarry sites near Barrigada Heights. The 
average fill area is 8 sqm. 

4.2 Watersheds 

The watersheds were produced using the delimited fill areas. Figure 4.4 shows that each 
watershed contains a fill area greater than 300 sqm, and the overflow point is where the fill area 
meets the watershed boundary. The largest watershed on the NGLA covered 4.88 sq mi and is 
located in the northwest area. However, fill areas have varying depths of more than 20 feet 
within a watershed, and their boundaries may be subject to basin delineation (see Section 4.4). 
The average area of a watershed is 0.025 sq mi (16 acres). There are more than 3,000 watersheds 
scattered across the plateau basins. 

4.3 Runoff Paths 

To obtain runoff paths, several GIS spatial analysis hydrology tools were applied. These tools 
included flow direction, flow accumulation, and Strahler stream order. Figure 4.5 shows two 
kinds of runoff paths, watershed runoff paths and overflow runoff paths.  



25 

 
Figure 4.1 Fill depth. The deepest fill depth is at the old Perez Bros Inc. Quarry, 175 ft (red 
arrow). 

 
Figure 4.2 Fill area analysis feature, unfiltered. An undelimited fill analysis includes fill areas of 
less than 1 sqm that would produce an overwhelming delineation of insignificant watersheds. 
However, since sinkholes can be smaller than 1 sqm, a fill area or closed surface depression 
suggest that there may be a sinkhole within. Fill areas are often considered suspect sinkhole, as it 
may or may not have a sinkhole. Most surface depressions have a high probability of resulting in 
dolines in a karst terrain. 



26 

 
Figure 4.3 Fill area delimited—greater than 300 sqm. In a statistical analysis, 300 sqm appear to 
be a proper minimum area for delineating watersheds, as each watershed contains a single fill 
area in the analysis. 

 
Figure 4.4 Watersheds of delimited fill areas. Fill area less than 300 sqm (black) are layered 
beneath the blue fill area. The overflow point is where watershed meets the blue fill area, with 
the exception of fill areas greater than 20 ft deep as delimited, further discussed in the plateau 
basin delineation. 
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Figure 4.5 Runoff paths. Strahler stream order values less than 5 are watershed runoff paths, 
greater than or equal to 5 are overflow runoff paths, which assumes the fill area is shallow 
enough to overflow into the next watershed fill area. The watersheds and its runoff paths 
resemble a polygonal karst terrain (Ford and Williams, 2007). 
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Watershed runoff paths are flow paths within the watershed that may carry runoff rainwater from 
the watershed boundaries to the fill area in the watershed. The watershed layout and watershed 
runoff paths are characteristic of a polygonal karst landscape (Ford and Williams 2007). 
Overflow runoff paths connect a series of watershed fill areas that have fill depths less than 20 
feet deep (see delimitation, Chapter 1). Overflow runoff paths may link a series of watersheds as 
tributary watersheds that terminate at the focal watershed. A focal watershed may have several 
tributary watersheds. Tributary watershed delineation are set for a next project phase.  

4.4 Plateau Basins 

Plateau basins were derived from a filled DEM. A plateau basin contains tributary watershed(s) 
and a focal watershed (see Figures 1.2 and 2.2), and at minimum contain a single focal 
watershed. A plateau basin with several focal watersheds with a deep fill depth greater than 20 
feet, a delimitation (Chapter 1), was further divided along a tributary watershed divide, where the 
neighboring tributary watersheds flowed into different focal watersheds. 

A total of 60 plateau basins were delineated. These basins define a total plateau area of 68.88 sq 
mi. The Mokfok Basin is the largest plateau basin identified with an area of 5.3 sq mi. Figure 4.6 
and Figure 4.7 illustrate the focal watershed of the Mokfok Basin and the Mokfok Focal 
Watershed. The fill area of this focal watershed has a maximum fill depth of more than 36 ft. The 
fill area extends into the Mache’che’ Basins, since the fill area has several depressions that are 
greater than 20 ft. Thus, the Mokfok doline fill area may be further divided, considering the 
runoff paths and watersheds as boundaries for selecting the division. 

The plateau basins were given CHamoru names by the Kumisión I Na’an Lugåt Guåhan (Guam 
Place Names Commission, Underwood et al. 2021). Figure 4.8 illustrates the official Plateau 
Basin Map with CHamoru names determined by the commission committee. Table 4.1 lists, by 
area size, the 60 Plateau Basins identified and named. The coastal basins were left as originally 
delineated and not officially named, with the exception of Achai coastal basin, in the northwest 
point area, and Sesonyan Basin that span over the Hagåtña, Ma’ina, Barrigada, and Mongmong-
Toto-Maite areas. The Mokfok Basin is the largest Plateau Basin with an areal coverage of 5.3 sq 
mi (Figure 4.7). Five additional large area plateau basins are Dédidu (4.08 sq mi), Gayinero (3.79 
sq mi), Guaguayon (3.37 sq mi), Upi (3.17 sq mi), and Lupok (2.65 sq mi). Figure 4.9 illustrates 
the plateau area as defined by plateau basins. 

4.5 Background Maps, Contours, and Production Wells 

The two background images used were flow direction and first-return hillshade. Gray shade flow 
direction (derived from bare-earth DEM) provides great contrast, revealing faults and slopes very 
well (Figure 4.10). LiDAR based bare-earth DEM derived contours of 10 ft, 50 ft, and 100 ft 
were added for quantifying grades and elevations. First-return hillshade (LiDAR based) reveals 
structures, useful for storm drain management in urban areas (Figure 4.11). However, the online 
Web MApps allow the user to select from several other background base maps such as areal 
imagery and other ESRI available products. Other additional features include the production 
wells and their GEPA regulation well head protection zones (300 ft and 1000 ft, radial buffers). 
Other map features are available, and their availability is discussed in the next section.
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Figure 4.6 Mokfok Plateau Basins, GWA production wells, and well head protection zone.
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Figure 4.7 Mokfok focal watershed and runoff paths. 
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Figure 4.8 CHamoru name of Plateau Basins (Underwood et al. 2021). A total of 60 plateau basins were 
named.
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Table 4.1 Plateau Basins of the NGLA (sorted by area size). 

Plateau Basin Name Area sq mi  Plateau Basin Name Area sq mi 

Mokfok 5.30  Mågua’ 0.74 

Dédidu 4.09  Kaskåhu 0.67 

Gayinero 3.79  Lumuna 0.55 

Guaguayon 3.37  Urunao 0.54 

Upi 3.17  Tiyan 0.49 

Lupok 2.65  Metgågan 0.48 

Ukudo 2.50  Hinapsan 0.48 

Machanao 2.44  Maga' Basin 0.47 

Lu'ayao 2.37  Ipapao 0.46 

Alakunao 2.32  I Piga' 0.46 

Mache'che' 2.15  Pali'e 0.46 

Mangilao 2.13  Ungåguan 0.42 

As Tobias 2.10  Lafak 0.39 

I Sengsong 1.77  Barigåda 0.35 

Togua' 1.65  Tutuhan 0.32 

Adakao 1.57  Tålagi 0.30 

Otdot 1.56  Haputo 0.30 

Finagua'yok 1.49  Lålo' 0.29 

CHagui'an 1.30  Ague' 0.28 

Sånta Rosa 1.29  Patai 0.25 

Fafalu 1.28  Pågu 0.23 

Halåguak 1.16  Litekyan 0.20 

Tåguak 1.09  Sosiu 0.17 

Kaiguat 1.06  Tamuneng 0.16 

Tanguisson 0.97  Laguåña 0.15 

Tailalo' 0.94  Fanacho'an 0.12 

Matåguak 0.93  Pugua' 0.09 

Pinati 0.88  Fadi'an 0.09 

Leyang 0.87  Ma'ina 0.05 

Hila'an 0.72  Sinahånña 0.03 

   Total 68.9 
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Figure 4.9 The Northern Guam Plateau area as defined by plateau basins. The dark gray areas are 
coastal basins. The plateau area is about 68.9 sq mi.
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Figure 4.10 Flow direction basemap and contours. 

 
Figure 4.11 First return hillshade with imagery basemap and contours. 
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4.6 WERI Web MApps: Surface Hydrology of the NGLA 

WERI Web MApps are a collection of interactive web-based map applications. These online 
maps are made available on the Guam Hydrologic Survey website, in the main drop-down menu,  
under Library, select Interagency Maps: 

https://guamhydrologicsurvey.uog.edu/index.php/interagency-maps/ 

Under Maps by Organization, WERI, select Surface Hydrology to open its map information site:  

https://guamhydrologicsurvey.uog.edu/index.php/2021/08/23/surface-hydrology/ 

Scroll down the page to the Web MApp View section and select either Mobile View for a QR 
code or Desktop View to open the Surface Hydrology of the NGLA Web MApp, link:  

https://werinch2018.maps.arcgis.com/apps/webappviewer/index.html?id=7f506c88a9574
7aa8774b0c0d311d7da 

Or simply select the large sample image at the top of the page. 

This hydrologic Web MApp has an “About” panel on the left, containing general information of 
the map (Figure 4.12). The panel can be made hidden by selecting the left arrow button at the 
middle right edge tab of the panel. Basic map widgets are on the top left: zoom (+ and -) and 
default extent (home icon). Bottom center of the Web MApp is a tab (upright arrowhead) when 
selected opens a panel of feature attribute tables, organized in a feature table tab interface. Notice 
some basic features have no attribute information. Select the down arrowhead tab to close the 
attributes panel. There are several hydrologic Web MApps, and all have map widgets (app 
function icons) that toggles an app function, located at the right side of the top bar (see example 
figure 4.12). Selecting any of the widgets opens/closes a panel. The first widget from the left is 
the Legend (symbology). The next widget is the Layer List. Notice that other map features (e.g., 
buildings, landmarks, etc.) are also available, but are turned off upon opening the Web MApp. 
Select the checkbox of a layer to make it visible or uncheck to turn it off. The third widget from 
the left is Add Data, which prompts a Search that includes URL access, or file upload of selected 
formats. These formats include shapefiles (shp) and CSV, KML, GPX, and GEO JSON file 
types. The fourth widget provides access to the Basemap Gallery which includes a collection of 
ArcGIS Online basemaps (e.g., Imagery, Streets, etc.). The next widget is Draw, which allows 
the user to mark up the map with draw mode toggles for markers, lines, shapes, and text. Second 
to the last is the Measurement widget. This widget can be applied to measure distance, area, and 
coordinate point position with a choice of degrees minutes and seconds (DMS) or in decimal 
degrees. The last widget allows printing. A menu is provided to select printing layout and file 
format. 

Three hydrologic Web MApps are available in the Interagency Maps web page. Figures 4.13 
through 4.15 show these as the surface hydrology with production wells and well head protection 
zones, a first-return LiDAR background imagery (excellent for urban stormwater development), 
and a CHamoru name of basins map in the Kumisión agency section. A fourth Web MApp, in 
the WERI section is a terrain analysis with the hydrologic features, see section 4.7 below. 
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Figure 4.12 WERI Web MApp interface. 
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Figure 4.13 WERI Web MApp: Surface Hydrology of the NGLA (flow direction basemap). 

 
Figure 4.14 WERI Web MApp: Surface Hydrology of the NGLA (first return LiDAR based 
hillshade).
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Figure 4.15 WERI Web MApps: Limestone Plateau Basins of Northern Guam, CHamoru place names.
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4.7 WERI Web MApps: Terrain Analysis of the NGLA 

In the process of developing the surface hydrology, a terrain analysis was also made to study the 
geomorphology and fundamental geologic features. A preparatory hydrologic spatial analysis 
flow direction map provided a background that revealed an interesting enhancement of the 
terrain. LiDAR based contours helped in drawing interesting lineaments which may possibly be 
geologic fault strikes. It was also found that large natural surface depressions and a string of 
surface depressions tend to run along these lineaments. The terrain analysis also identified 
parasitic faults found near large surface depressions, such as the Mokfok Doline. These map 
features, as shown in Figure 4.16, may be helpful in explaining the occurrence of dolines and 
sinkholes in the NGLA and provide further understanding of the karst terrain. 

 
Figure 4.16 WERI Web MApps: Terrain analysis of the NGLA.



 

Chapter 5 

DISCUSSION 

This chapter provides discussion of resulting surface hydrologic features of the NGLA. The 
development of these features and results were described in detail previously in Chapters 3 
and 4. The discussions include the usefulness of the mapped features, especially for developers, 
regulators, and investigators. The technical applications refer to the geologic, hydrologic, and 
hydrogeologic nature of the NGLA. Additionally, the fundamental and well-defined hydrologic 
map products will prove to be integral for all and any future NGLA research and development of 
future groundwater protection strategies. 

5.1 Fill Areas (closed surface depressions) 

Not all resulting fill areas are sinkholes. All fill areas on the map are considered as suspect 

sinkholes that there may be a chance that water accumulates into the closed surface depression 
where a sinkhole may have developed. It is a suspect sinkhole on the map unless it has been field 
verified as a sinkhole. These fill areas are thought of as suspect sinkholes because surface 
depressions in a karst terrain are usually a result a subterranean cavity collapse. It is suspect, 
however, because some of the closed surface depressions have been field verified to be sinkholes 
and some as non-sinkholes. Large fill areas are dolines that occur along a major fault. The major 
faults often have parasitic faults that add to the extent of the doline and other surrounding surface 
depressions (Jenson et al. 2019). These dolines may be (often are) larger than the fill area since 
the analysis only takes the fill elevation to the watershed overflow point. If a mapped fill area is 
verified as a sinkhole, then contaminants transported by stormwater runoff from tributary 
watersheds may have a possible direct pathway to the fresh groundwater source. 

Regulators should require plan development over a fill area (suspect sinkhole) to be flagged, 
requiring further analysis and field investigation. A verification is finding geological 
characteristics of a sinkhole in and around the fill area. As an investigator’s map, a more accurate 
fill areas with fill depth delineation are very informative and useful. Surrounding fill areas may 
give insight to a larger surface drainage system. Deep fill areas with sharp drops in elevation are 
very characteristic of sinkholes, and very deep ones may suggest a possible focal watershed (no 
chance of filling and overflowing). The map provides a “big picture” view that is useful for 
planning a well strategized field trek and investigation. An investigator should also look at the 
size of the fill area’s watershed and its content, which includes scanning for potential sources of 
contaminants. For developers and all authorizing parties at stake, these surface hydrologic maps 
are the best way to begin any development plan over the NGLA. 

5.2 Watersheds 

Surface watersheds (fill area watersheds), determined using the techniques described in Section 
3.5 above, are the areas that can capture and infiltrate rain/stormwaters. Intense rainfall in a 
watershed can cause overland flow and runoff to the watershed’s fill area. Any contaminant 
producing activities in these areas could result in possible contaminant flow into that fill area. If 
that fill area happens to contain a sinkhole, then contaminants released in the watershed have a 
possible direct pathway to the NGLA. 
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As defined in chapter 2, there are three watershed classes: a unit watershed, tributary watershed, 
and a focal watershed. The watersheds that overflow a fill area and connects to a series of 
downstream watersheds are called the tributary watersheds. A tributary watershed is a natural 
structure for cascading runoff to occur and deliver a large collection area of watersheds to 
overflow into a focal watershed. Focal watersheds are considered as a major source of 
stormwater drainage into the aquifer. 

For developers and regulators, watersheds delineate the extent of the rain catchment area. A large 
catchment area means more water accumulation. It spans a larger area of coverage if the 
watershed is a part of a tributary watershed. Even though a plan to build and have contaminant 
generating activities are not in a suspect sinkhole, the plan should include assessment of 
contaminant generating activities. These activities can produce contaminants that can be carried 
away by stormwater, along runoff paths in the watershed. 

5.3 Watershed Runoff Paths 

Watershed runoff paths, determined using the techniques described in Section 3.4, are flow paths 
that transport rainwater runoff directly into the previously described fill areas. Any contaminants 
released by activities in areas upstream of a runoff flow path could travel downstream through 
these runoff paths. Again, this could result in possible contaminant flow downstream through the 
flow paths. Also, if the flow path eventually leads to a verified as a sinkhole, then contaminants 
flowing in the runoff path are provided a possible direct pathway to the NGLA. 

5.4 Overflow Runoff Paths 

Overflow runoff paths, determined using the techniques described in Section 3.4, are determined 
using an accumulation analysis of a filled DEM. This accumulation is only accurate if the surface 
depressions completely fill with runoff water. Large sinkholes may or may not fill depending on 
rainfall intensities, total storm rainfall accumulations, and antecedent ground moisture 
conditions. Most questionable are closed surface depressions (fill areas) of depths over 10 feet. 
Not all fill areas may be verified by observation during intense storms. It also may not be 
possible to observe the actual performance of these surface depressions during intense storms. 
The estimation of storm related infiltration rates that could depend on location, size, and depth 
require thorough field investigations. Observable clues may be noticeable during field 
investigations. These clues could include items such as watermarks, sediment, nostoc alga, and 
abraded rocks. Actual field practice should also include investigating the natural overflow points 
for evidence of overflow, erosion, and abrasion. Interviews with residents and flood first 
responders can also be helpful. Upon field verification of an unfillable watershed, the overflow 
runoff path is reported as a disconnect, and the watershed is terminal and becomes a focal 
watershed. The following downstream watershed is then considered the head watershed as it 
continues the overflow runoff path. 

5.5 Plateau Basins 

Plateau basins, determined using the techniques described in Section 3.5, are delineated using a 
basin analysis of the filled DEM. Plateau basin contains some if not all of the features previously 
described including: fill area, watershed, tributary watershed, focal watershed, watershed runoff 
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paths, and overflow runoff paths. At minimum, a plateau basin contains only a focal watershed 
and watershed runoff paths. Plateau basins also delineate an area’s top ridges, where the 
collection of runoff paths stay within the basin that also all connect to the basin’s focal watershed 
fill area. The two types of basins that were mapped included coastal basins and plateau basins. 
Coastal basins have runoff that reach coastal marine waters and plateau basins contain runoff 
waters that move into its infiltration sites and routes. Sixty plateau basins were mapped with 
respect to the delimitations set for the surface hydrology analyses, and each of the plateau basins 
were named by the Kumite of CHamoru name place. 

5.6 Coastal Basins 

Presently areas located within 4000 ft. of the shoreline are not considered to be in the 
Groundwater Protection Zone by GEPA. This 4000 ft. definition could be fine-tuned by using the 
topographic basin edges closest to the shoreline as the boundary of a new Groundwater 
Protection Zone. Those areas outside the designated plateau basins might also be of interest to 
those who are evaluating coastal zone impacts on the near shore environment. 

5.7 Practicality of the Surface Hydrology Map of the NGLA 

This map depicts the results of an initial all-encompassing surface hydrologic analysis of the area 
overlying the NGLA. The map also provides a framework for future more complete and detailed 
investigations. 

Large development contracts provide a project/contract boundary. This SEIS or “green box” 
describes the area of direct impact by the project under consideration. The surface hydrology 
maps developed by this study will help contractors and agency officials to evaluate the affects 
that can occur beyond the SEIS because of water movement from the project area into adjoining 
downstream surface watersheds and possibly directly into the NGLA. 

The surface hydrologic maps and Web MApps of the NGLA developed for this project provide a 
common and easy to use source of overlayed and detailed hydrologic information. Contractors 
and agency officials can use this common set of maps to develop successful strategies for 
management of new development over the NGLA. This same information can also help agency 
officials develop long term strategies for managing and mitigating development impacts over the 
aquifer.



 

Chapter 6 

CONCLUSIONS AND RECOMMENDATIONS 

This project examined and produced surface hydrologic features for areas over the NGLA. The 
hydrologic WERI Web MApp products modernizes the way we evaluate and proceed with 
groundwater protection as the island continues to develop atop our most valuable freshwater 
source. 

6.1 Accomplished Objectives 

The goals, purpose, and specific objectives in section 1.3 were accomplished. Fundamental 
hydrologic areas of fill, watershed, and basins of the NGLA plateau were delineated with respect 
to select conditions and delimitations, using the best available DEM. Runoff paths were 
produced, and overflow runoff paths and focal watersheds were identified. 

The generated hydrologic features, rasters, and background layers were overlayed in order to 
produce a clear and useful multilayered set of hydrologic maps. Four hydrologic maps were 
uploaded into ArcGIS Online, made into web maps, and then to web map apps. The four online 
hydrologic maps are one of the first sets of WERI Web MApp products that are made available 
on the Guam Hydrologic Survey website (sections 4.6 and 6.1). These Web MApp products are 
intended for use for anyone interested in the surface hydrology of the NGLA. These hydrologic 
Web MApps, including the terrain analysis, was first unveiled at the WERI Guam Advisory 
Council Meeting, November 2021. Training for interagency partners and anyone interested in 
learning to use the WERI Web MApp products was announced in the meeting, and a workshop is 
scheduled for 2022. 

6.2 Summary Conclusion 

An innovative hydrologic spatial analysis procedure was developed to identify various features 
of the NGLA plateau that determine how water travels across the land surface and eventually 
makes its way to the groundwater. The features developed included fill areas and depths, fill area 
watersheds, runoff paths, and plateau basins (Chapter 4). Tributary watersheds are identifiable 
and connected by overflow runoff paths that lead to a focal watershed. Some of the fill areas had 
already been identified as dolines and fill areas with swallow holes. Evidence of collapse was 
also found. These surface depressions and sinkholes may very well serve as contaminant 
pathways to the freshwater source. 

The hydrologic maps developed in this study updates the methods of assessment and re-evaluates 
and fine tunes previously used procedures for protecting the aquifer. Map features and rasters are 
orderly overlaid to produce a hydrologic map of storm accumulation/collection paths and areas. 
This map is organized as a truly valuable tool for assessing and determining the best water 
source protection strategies. This in turn will help GEPA and GWA promote cooperative project 
development of areas of interest overlying the NGLA.  

And now island developers have a very useful hydrologic map to make better construction plans 
with water source protection in mind. In the past, impact assessments were primarily evaluated 
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within the boundaries of a project area. The maps provided in this study show how development 
activities in one area can impact areas downstream and completely outside the project area’s 
boundaries. It is imperative that these possible off-site impacts be considered when evaluating 
the possible environmental impacts of a proposed project and to develop mitigation plans to 
minimize any possible impacts. The hydrologic Web MApps developed by this project will be 
key to providing evaluation of both on-site and off-site environmental impact considerations. 

Another key aspect of the project is that the user of these hydrologic Web MApp does not have 
to be an expert in using GIS. The online product has a common app and GIS layers framework. 
The workshops and training that are proposed will ensure that the data are useful and available to 
both regulating agencies and those proposing development over the aquifer. Once users are 
familiar with using the application, they will be able to easily evaluate the hydrologic 
environmental effects of any proposed development. The bottom line is that the NGLA will be 
better protected both now and in the future for all the people of Guam. 

6.3 Recommendations 

The hydrologic WERI Web MApps should be considered as part of a living document. As new 
projects are proposed, new field investigation will uncover information that can be easily 
included in the existing WERI Web MApp products. The maps included in this investigation 
should not be considered as end point determinations, but the starting point for a living and 
updated data document. 

6.3.1 Annual Workshop, Recommended Use 

In order to take advantage of the data and online hydrologic maps, it is necessary that a series of 
workshops be held. These workshops will include a short introduction to the GIS techniques 
used and detailed instruction on how to access and use the maps available in the web application. 
The workshops will be designed for developer engineering staff, Federal agency officials 
overseeing planning and construction of new facilities, and for agency officials at Guam EPA, 
GWA, and Guam Land Management who are involved in regulating development over the 
aquifer. It is proposed that the first workshop be held in 2022 with follow-ups on an annual basis. 
Mini workshops on special topics concerning the WERI Web MApp hydrologic products could 
be provided on an as requested basis. 

6.3.2 Dissemination of Report and Maps 

This report is available on both the WERI, University of Guam (https://weri.uog.edu) and Guam 
Hydrologic Survey (https://guamhydrologicsurvey.uog.edu/) web sites. WERI Hydrologic Web 
MApp products can be found at the Guam Hydrologic Survey web site, under the Library Menu, 
Interagency Maps (see section 4.6 and 6.1). 

6.3.3 Findings for Further Study 

The maps produced in this investigation is not the end point determinations, rather a starting 
point for a living and updated data document. A second phase will pursue further refinements, 
specifically to delineate tributary watersheds and define the runoff paths within fill areas. Also, 
verifying focal watersheds is a recommendation. Furthermore, there is a continued need to 
identify which fill areas are truly sinkholes and provide quick flow paths to the aquifer.
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Appendix 

2012 Guam LiDAR Metafile 

The LiDAR data was captured using a twin-engine fixed wing aircraft equipped with an Optech 
ALTM Gemini LiDAR system. This system consists of Airborne Global Position System 
(ABGPS), inertial measurement unit (IMU), and laser sensor. The ABGPS collects XYZ 
coordinates of the laser sensor and the IMU calibrates the orientation of the aircraft. During 
flight, laser pulses are reflected from features on the surface and the system collects this data. 
The acquired LiDAR data receives a preliminary review to assure that complete coverage is 
obtained and to ensure the absence of data gaps. 

Acquisition parameters: 

• Scanner - Optech Gemini SN# 03SEN145 and 07SEN201 

• Flight Height: 450 to 600 meters above mean terrain 

• Scan Rate: 45 Hz 

• Field of View: 22 degrees 

• Pulse Rate: 70 kHz 

Inertial Measurement Unit (IMU) processing parameters: 

• Processing Programs and versions: Applanix - POSGPS and POSProc, versions 4.4, 
MMS version 5.2 

•  Max separation between base stations during LiDAR collection: 0.12 m 

•  IMU processing monitored for consistency and smoothness: Yes 

• GPS and IMU processing software: Optech's Dashmap version 5.20 and Applanix 
version 4.4 

This study used topographic Digital Elevation Model (DEM) data gathered using Light Detection and 
Ranging (LIDAR) techniques in 2012 as the basis for determining the geometry of all drainage features 
over the Northern Guam Lens Aquifer (NGLA). This data was gathered  
by AeroMetric, Inc. Complete documentation for the data is contained in the meta data files that 
accompany the DEM GIS files. Following are pertinent excerpts from the meta files: 

This task order was for production of surface model products of The Territory of Guam. The models 
are produced from data acquired using airborne Light Detection and Ranging (LiDAR) sensors. The 
data is calibrated, classified, and processed to produce surface models and products including 
Classified LAS, bare-earth Digital Elevation Models (DEM), intensity raster images, shapefiles of 
road centerlines, forest canopy, building footprints and breaklines of surface hydrology. 

The United States Geological Survey requested surface data products and models that indicate surface 
conditions, drainage, vegetation, transportation routes and building structures to aid in analysis of 
land use, transportation, hydrologic, forest vegetation and recreational management. Data and 
products are referenced to the Universal Transverse Mercator (UTM) Coordinate System - Zone 55, 
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based on the World Geodetic System of 1984 (WGS84) in meters. The vertical reference is Guam 
Vertical Datum of 2004 (GUVD04) in meters. 

The vertical accuracy assessment of the data has a project requirement to achieve a RMSE of 12.5 cm 
(0.41), a Fundamental Vertical Accuracy (FVA) of 24.5 cm (0.80 ft) 95% confidence level, a 
Consolidated Vertical Accuracy (CVA) of 36.3 cm (1.19 ft) 95th Percentile and a target value for 
Supplemental Vertical Accuracies (SVA) of 36.3 cm (1.19 ft) 95th Percentile. 

The Fundamental Vertical Accuracy (FVA) listed above is determined with checkpoints 
located only in open terrain where there is a high probability of having LiDAR return from 
the bare-earth ground surface and where errors are expected to follow a normal error 
distribution. While FVA values of 24.5 cm (0.8 ft) are not too impressive compared to actual 
field survey determinations, they are by far the most accurate elevation data available for use 
in hydrologic spatial analysis. Note that that the hydrologic spatial analysis is dependent 
more on the relative elevation of the DEM cells rather than the actual values that could be 
determined using ground survey or GPS methods. The relative elevations accuracy of the 
bare-earth DEM and can be assumed to be better than the FVA values. We therefore assumed 
that the bare-earth DEM values are adequate for this study. When and if future new more 
accurate DEMs are available the spatial analysis processes described in this report can be 
easily be reapplied to that new data. 

LiDAR DEM: A second text file accompanied the LIDAR data. Following is an excerpt from 
that file: 

• Lidar 2012 data by USGS.  

• DEM was created by Ross Winans from NOAA OCM upon request by Maria Kottermair 
March 2016. 

• DEM was then clipped with polygons derived from the lidar data itself (provided by Ross 
Winans) to get rid of the interpolation artifacts along the coastline. 

• NOTE: there are some small gaps in the interpolated dataset that was provided by NOAA 
and may have to do with gaps in the original data. 

• Credit for lidar data: USGS



 

 


